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GLOSSAIRE

DW Biomasse séche (Dry Weight)

EIE Espéce d’'importance écologique

FW Biomasse fraiche (Fresh Weight)

LAI Indice de surface foliaire (Leaf Area Index)

VAS Végétation aquatique submergée

ZIP Zone d’intervention prioritaire. Comité ZIP : organismes régionaux de

concertation et d’action, dont le mandat est de regrouper les principaux

usagers du Saint-Laurent.



INTRODUCTION

La zostére marine est la principale phanérogame marine formant des herbiers marins le long des
cbtes québécoises. Classée espéce d'importance écologique (EIE) par Péches et Océan Canada
depuis 2009', elle contribue a la grande productivité et au maintien de la biodiversité des milieux
cotiers tout en supportant de nombreux services écosystémiques?. A I'échelle mondiale, les éco-
systémes de zostére marine sont globalement en décroissance? et il est nécessaire de mettre en
place des programmes de monitorage a long terme pour comprendre I'impact des changements
globaux et des perturbations locales sur la dynamique des herbiers. L’un des enjeux principaux
dans ces suivis est la nécessité de suivre des protocoles unifiés, répondants a de larges ques-
tions. Cependant, ces suivis sont déployés par des entités aux structures et aux moyens d’action
variés (OBNL, Comités ZIP, entités gouvernementales, groupes de recherche universitaire, Pre-
miéres Nations). Le déploiement et |a réalisation des suivis doivent étre adaptés aux capacités et

réalités des gestionnaires locaux.

Ce protocole est le fruit d’'une réflexion menée pour standardiser les protocoles d’échantillonnage
des herbiers de zostéres marine a travers les différents programmes de monitorage, restauration
et suivi de qualité des eaux au Québec. Sa premiére version a été rédigé en hiver 2024 a partir
de méthodes appliquées et des données récoltées dans les herbiers de zostéres marines de la
Baie de Rimouski* en 2020, 2022 et 2023, de I'Anse aux Huitres® (Kegaska) et de la Baie des
homards® (Port-Cartier) en 2019 et 2023, de la péninsule de Manicouagan’ (Baie-Comeau) en
2019, en partenariat avec les Comité ZIP Rive-nord de I'estuaire, Comité ZIP Céte-Nord du Golfe,
Comité ZIP du Sud-de-I'Estuaire et différentes équipes de recherche de I'Université du Québec
a Rimouski (UQAR). Ce protocole a été ajusté suite aux échantillonnage terrain réalisé en 2024
par les équipes nommeées ci-haut. Ce protocole propose une série de métriques mesurées a
différentes échelles organisationnelles (cellule, individu, communauté, écosystéme), reliées a
I'état écologique des herbiers marins le long de la section marine du Saint-Laurent (excluant les
VAS d’eau douce). Afin de capturer la variabilité spatiale présente au sein des herbiers, ce pro-

tocole présente un plan d’échantillonnage en cible (voir la section Plan d’échantillonnage).
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4 ISMER-UQAR, Chaire UNSECO en gestion intégrée des systémes marins (dir. Fanny Noisette)
5 Comité ZIP Cote-Nord du Golfe

6 IDEM

" UQAR et UQAC, Projet WISE-Man



METRIQUES

Les indices de recouvrement, d’abondance des épiphytes et de nécrose des plants par quadrat
(indices semi-quantitatifs ; voir échelle ci-dessous), la longueur moyenne et maximale par qua-
drat, la densité des plants et la biomasse fraiche (FW) par unité de surface sont évaluées direc-
tement sur le terrain. Ce protocole permet aussi (en fonction des moyens dont I'équipe disposera)
d’évaluer le nombre moyen de feuilles par plant, I'indice de la surface foliaire (LAl ou Leaf Area
Index) par échantillon et la biomasse séche (DW) par unité de surface. S'il est impossible pour
I'équipe de traiter les échantillons pour obtenir la DW, celle-ci peut étre déterminée a partir d’'une
relation masse fraiche-masse séche établies a partir de données précédemment récoltées a Ri-

mouski en 2023. Un indice préliminaire est présenté dans la section Indices (p. 16).

Classe 0 1 2 3 4 5

Recouvrement | 0% 0a<25% 254<50% |50a<75% |75a<100% | 100%

PLAN D’ECHANTILLONNAGE ET MATERIEL

Ce plan a été choisi en raison de sa facilité d’application dans les milieux médiolittoraux (a pied,
a marée basse) et infralittoraux (en plongée). De maniére optimale cet échantillonnage devrait
étre effectué a la méme période chaque année pour faciliter les comparaisons interannuelles. La
période recommandée correspond au moment du maximum de biomasse (mi-fin juillet pour I'es-
tuaire maritime). Cette période pourrait varier d’'une région a l'autre, en fonction de la phénologie
des herbiers. L’échantillonnage devra étre déployé un minimum d’une fois par été dans chaque
site de I'herbier. Un site de I'herbier est considéré comme une aire qui englobe des conditions
(substrat, fragmentation, gradient de profondeur, etc.) sensiblement uniformes. Lorsque I'herbier
est trés grand, il peut y avoir plusieurs sites par herbier (p. ex : bordure de I'herbier et centre de
I'herbier).
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Figure 1 : Design d’échantillonnage en cible. Chaque ton de vert représente une zone d’échantillonnage.
Réplication : 3 échantillons (position aléatoire dans chaque zone d’échantillonnage) pris sur chacun des tran-

sects ; 4 transects de 50 m par cible.

Design d’échantillonnage en cible (figure 1)

[1 Mouillage avec sondes enregistrant les conditions environnementales telles que
la température, la salinité, la pression et la lumiére;

71 Transect : ruban de mesure extérieur (= 50 m);

[1 2 piquets en plastique ou pole de PVC 70 a 100 cm (pour fixer le transect);

0 GPS.
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Mouillage (figure 2)

Un mouillage muni de sondes paramétriques est installé dans I'herbier pour la durée de

la saison estivale. Les sondes mesurent les paramétres suivants :

1. Lumiére et température : HOBO Pendant MX Temperature/Light Data Logger

MX2202 connexion Bluetooth (https://www.onsetcomp.com/products/data-log-

gers/mx2202) OU HOBO Pendant Temperature/Light 64K Data Logger UA-002-
64 (https://www.onsetcomp.com/products/data-loggers/ua-002-64) connexion par
fila HOBOWare.

2. Pression/hauteur d'eau: HOBO Water Level Data Logger U20L-04 (13 ft)
(https://www.onsetcomp.com/products/data-loggers/u201-0x) connexion par fil a
HOBOWare (facultatif)

3. Conductivité/salinité : HOBO Salt Water Conductivity/Salinity Data Logger U24-
002-C (https://www.onsetcomp.com/products/data-loggers/u24-002-c) connexion
par fil a HOBOWare (facultatif)

Figure 2 : Schéma du mouillage déployé dans I'herbier. Le mouillage doit étre fixé au fond avec une ancre et
identifié par une bouée flottante (sphere rose). La longueur de la corde de la bouée doit étre équivalente a
1,5 x la hauteur d’eau a marée haute. Le schéma est présenté a titre indicatif, la forme et des dimensions du
mouillage peuvent varier en respectant les conditions suivantes : les capteurs de pression/hauteur d’eau (2)
et de conductivité/salinité (3) doivent étre installés le plus pres du substrat paralléle au sol ; les capteurs de
lumieres (1) doivent étre disposés de fagon a ne pas se faire de I'ombre. Le premier doit étre placé le plus

pres du substrat et le second a une hauteur < 1 m du substrat.


https://www.onsetcomp.com/products/data-loggers/mx2202
https://www.onsetcomp.com/products/data-loggers/mx2202
https://www.onsetcomp.com/products/data-loggers/ua-002-64
https://www.onsetcomp.com/products/data-loggers/u20l-0x
https://www.onsetcomp.com/products/data-loggers/u24-002-c

Le mouillage est composé d’une structure a base triangulaire en aluminium avec en son
centre une tige perpendiculaire en aluminium (figure 2). Les capteurs doivent étre fixés au
mouillage a I'aide d’attaches rapides (zip-tie ou colliers rilsan) résistantes aux intempéries

et au rayonnement UV avec cran en inox (par ex: https://new.abb.com/pro-

ducts/7TAG009210R0050/ty28mx). La base triangulaire peut étre remplacée par une

base ronde composée de poids d’entrainement.

Personnel requis : 3 personnes

Temps estimé par personne par site (n = 4 transects déployés par site) :

e Préparation : 1 personne x 1 jour

e Travail sur le terrain : 3 a 4 personnes x 1 jour (2 journée :AM)

e Traitement des échantillons (biomasse) : 2 personnes x 1 jour (2 journée :PM)?
o Mesure de la LAl et saisie des données : 1 personne x 2 jours

Matériel pour le terrain

[] 2 grands sacs a dos;

Boussole pour placer les transects a 90°;

12 grands sacs plastique hermétique (ZIPLOC) préidentifiés

3 quadrats 50 cm x 50 cm percés et munis de piquet pour ancrer dans le sédiment;
3 quadrats 25 cm x 25 cm percés et munis de piquet pour ancrer dans le sédiment;
2-3 paires de ciseaux ;

Ruban a mesurer en nylon (ruban de couture);

Feuilles de notes ou cahier de terrain résistant a 'eau;

Vignettes d’identification (site, transect et quadrat) facultatif:

Crayons a mine;

Grenouillere pour chaque technicien-ne-s de terrain (Waders) ;

Gants étanches et doublés (si nécessaire pour I'eau froide);

Appareil photo résistant a I'eau facultatif,

o o 0o o o o oo oo o0ogoogo O

Glaciére + pain de glace pour le transport facultatif ;

8 Le travail de terrain et le traitement des échantillons se font la méme journée, idéalement, par
les mémes personnes.


https://new.abb.com/products/7TAG009210R0050/ty28mx
https://new.abb.com/products/7TAG009210R0050/ty28mx

Traitement des échantillons en laboratoire (LAI, FW et DW)

2-3 essoreuses a salade;

Papier absorbant ou chamois.

Balance de précision;

Sacs en papier brun (pesés aprés séchage)®;

Régle 30 cm en plastique ;

Etuve

Tableau blanc (ou surface blanche);

Support universel ;

Appareil photo (ou téléphone cellulaire avec une bonne résolution) ;

Crayon permanent ;

o o o o o o 0o o oo dg

Etiquettes d’identification ou crayons effagable pour tableau blanc.
METHODE

Préparation (4 a 5 jours précédant le terrain)

Imprimer la feuille de terrain ou préparer le cahier de terrain (voir annexes);
Charger l'appareil photo et le GPS ;

Identifier les sacs plastique hermétiques (date, site, transect, quadrat) ;

O o O o

Biomasse seche (DW) : sécher les sacs de papier 48 h a 60 °C. Identifier les sacs

d’'un numéro unique, peser les sacs et noter la masse séche sur le sac.
Terrain

1. Atteindre le mouillage ou le point GPS désigné comme le centre de la cible. Planter
une pole de PVC dans le substrat pour désigner le centre de la cible ;
2. Déployer le ruban a mesurer depuis le centre en direction du large sur 50 m. Noter la
direction dans laquelle est déployé le transect a I'aide de la boussole (p. ex. 35° NE) ;
3. Sélectionner une (1) station aléatoirement dans chaque zone de la cible :
* |ntérieure:0a 17 m;
= Moyenne: 17 a33 m;

= Extérieure 33 2 50 m.

911 est essentiel de sécher les sacs de papier a I’étuve et de noter leur masse une fois complétement secs
avant de les utiliser pour les biomasses de zostere. L’humidité pourrait fausser les données de DW.



Pour chaque station :

4.

A l'intérieur du grand quadrat (50 cm x 50 cm) noter le pourcentage (a 5% prés) ou la
classe de recouvrement (0 a 5, voir section Métriques), de couverture par les plants
de zostére, par les épiphytes et par les plants nécrosés'® ainsi que le recouvrement
du quadrat par les autres macrophytes (algues brunes, algues vertes, etc.);

Si nécessaire, photographier le grand quadrat avec les vignettes d’identification (site,
transect et quadrat);

A l'intérieur du grand quadrat, déposer aléatoirement le petit quadrat (25 cm x 25 cm).
Exclure les plants qui se trouvent a I'extérieur du petit quadrat en passant les mains
au ras du substrat en suivant le contour du quadrat et tirer délicatement les feuilles
vers I'extérieur, fixer le petit quadrat au substrat a I'aide de piquets en métal ;
Rassembler tous les plants dans une main (former un bouquet) pour s’assurer que
tous les plants ont bien été répartis de part et d’autre du quadrat.

Cueillir et compter les plants dans le petit quadrat un par un en coupant au ras de la
racine avec l'ongle ou avec des ciseaux. Noter le nombre de plants en floraison
(feuilles plus longues et rigides, vert clair et contenant des graines). Si la densité dans
le quadrat est uniforme et élevée, dénombrer seulement %2 quadrat et noter la pro-
portion du quadrat qui est cueillie. Noter le nombre de plants cueillis et éviter de faire

des calculs directement sur le terrain.

NOTE : couper les plants entre le nceud 0 et le nceud 1 (en dessous du renflement présent

sur la gaine du plant; voir figure 3)

9.

Placer les plants dans le sac en plastique identifié pour la station et refermer le sac
hermétiquement. Rapporter les échantillons au laboratoire en les gardant au frais dans

un sac a dos ou dans une glaciére.

10. Répéter les étapes pour les trois autres directions cardinales, en pivotant le transect

dans le sens horaire a 90° (p ex : SE -> SO -> NO -> NE).

10 Le pourcentage de recouvrement du quadrat et non le pourcentage de plants qui sont nécrosés. Par
exemple : si le quadrat a un recouvrement de 60% de zostere et que la moitié de celles-ci sont nécrosés,
le pourcentage de recouvrement par des plants nécrosés sera de 30%.
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Figure 3: Sectionner le plan en dessous du nceud (indiqué par la fleche).

Traitement en laboratoire

Biomasses et mesures morphométriques'"

Pour chaque échantillon :

11. Sortir les plants du sac et les agiter dans I'eau douce (6ter tous les épiphytes et les
invertébrés qui pourraient y étre attachés);

12. En les examinant un par un, couper les racines restantes sur chaque plant : a l'aide
d’une paire de ciseaux ou avec l'ongle, entre le nceud 0 et le nceud 1 (en dessous du
renflement présent sur la gaine du plant; voir figure 3) ;

13. Mettre de cbté trois plants médians (pour les mesures morphométriques) ainsi que le
plant le plus long de I'échantillon;

14. Placer le reste de I'échantillon dans I'essoreuse et faire tourner 3 fois, puis placer les
feuilles dans un sac en papier numéroté et prépesé. Garder le sac de cété en atten-

dant de compléter les mesures morphométriques ;

11 Deux méthodes peuvent étre utilisées pour estimer I'indice de surface foliaire (LAI) : par calcul & partir de la longueur et
la largeur (point 18 a 28) ou par estimation de I'aire des feuilles (points 29 a 39)

10
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Longueur maximale

15. Mesurer le plan le plus long et noter sa longueur sur la feuille terrain;

16. Essorer le plant et I'ajouter au reste de I'échantillon dans le sac de papier;
Pour chaque plant sélectionné (3 par échantillon) :

17. Couper les feuilles a la base de la gaine puis, sur une surface blanche, étaler chaque
feuille 'une a cbté de I'autre paralléle a une régle graduée, ainsi que la gaine perpen-
diculairement aux feuilles (figure 4). Pour faciliter le travail, les feuilles doivent étre
lissées sur la surface avec le bout du doigt et un peu d’eau ;

18. Installer 'appareil photo sur un support universel pour stabiliser I'appareil. L’appareil
doit toujours étre situé dans le méme angle et a la méme hauteur ;

19. Prendre une photo de toutes les feuilles, de la regle graduée et de I'étiquette d’'identi-

fication du quadrat (date, site, transect, quadrat, replicat) ;

bk el

2013/oq/lq
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Figure 4 : Toutes les feuilles d’un plant de zostere disséquées et étalées paralleles a I'étalon de mesure. Une

photo par plant, 3 plants par échantillon.

Exemple d’étiquette : [20-04-2023 _T01_QO02; R1] pour le plant (réplica) 1 de I'échantillon

du quadrat 2 sur le transect 1 récolté le 20 avril 2023).

11



20. APRES LES MESURES MORPHOMETRIQUES : Eponger les feuilles et remettre
tous les plants dans le sac de papier de biomasses. Peser le sac et son contenu pour
obtenir la masse humide ;

21. Placer ensuite les sacs a I'étuve a 60 °C pour 48 h, puis peser a nouveau pour obtenir

la masse séche.

NOTE : si un déshydrateur alimentaire est utilisé pour faire le séchage, le temps de sé-
chage pourrait varier. Pour s’assurer que la biomasse ait complétement séché, noter la
biomasse a plusieurs reprise (une a deux fois par jour) jusqu’a ce que la masse soit stable

3 pesées consécutives.

Détermination des mesures morphométriques pour calculer I'aire des feuilles avec logiciel

d’analyse photo ImageJ

22. Ouvrir la photo d’un plant dans le logiciel ImageJ'?
Etalonnage de la photo :

23. Avec l'outil Strait line tracer une ligne de longueur connue (p. ex : 10 mm) sur I'étalon
de mesure présent sur la photo (régle graduée);

24. Dans le menu Analyze, sélectionner I'option Set scale (figure 6). Une fenétre s’ouvrira ;

25. Dans la fenétre Set Scale entrer la longueur connue (10) dans la case Known distance

et 'unité de mesure (mm) dans la case Unit of lenght. Appuyer sur OK (figure 7).

12 | ogiciel d’analyse d’image gratuit et libre de droits. https://imagej.net/ij/download.htm|

12
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Figure 6 : Sélectionner I'outil Set Scale
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Figure 7 : Entrer la mesure et I'unité de mesure dans la fenétre Set scale (encerclé en rouge)

Mesure des feuilles :

26. Sur une premiére feuille, tracer une ligne allant de la base de la feuille a la pointe de
la feuille. Utiliser I'outil Segmented line lorsque la feuille est courbée de maniere a
maintenir la ligne au centre de la feuille (figure 5);

27. Dans le menu Analyze, sélectionner I'option Measure (ou Ctrl+M). Un tableau s’ouvrira

et la mesure sera indiquée dans la colonne Lenght;

Mesurer ainsi la longueur et la largeur de chaque feuille.
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Figure 8 : Utiliser I'outil Measure ou Ctrl + M pour déterminer la longueur d’une ligne tracée avec I'outil Seg-

mented line ou Strait Line.

Mesure de l'aire avec le logiciel ImageJ

28. Définir I'étalon de mesure avec l'outil Set Scale comme décrit aux points 23 a 25;

29. Transformer I'image en noir et blanc en utilisant I'outil Image > Type > 8-bit (figure 9);

30. Sélectionner l'outil Image > Adjust > Threshold. Dans la fenétre Threshold choisir les
options Default et B&W. Appuyer sur Apply (figure 10);

31. Sélectionner I'outil Analyze > Tools > ROl Manager (figure 11);

32. Cocher les options Show all et Labels de la fenétre ROl Manager Avec l'outil Wand,
sélectionner une feuille (elle sera encadrée en jaune) puis cliquer sur le bouton Add
dans la fenétre ROl Manager. Sélectionner ainsi toutes les feuilles une par une (figure
12);

33. Dans la fenétre ROl Manager, cliquer sur le bouton Measure. La fenétre qui s’ouvrira
indique la surface calculée en unité? (p. ex : mm?) de chaque feuille (figure 12).

34. Noter les mesures pour chacun des plants.
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Figure 9 : Pout transformer I'image en noir et blanc, sélectionner I'option 8-bit dans I'outil Type
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16



Protocole d’échantillonnage des herbiers de zostere marine dans le systeme Saint-Laurent (mars 2025)

4 2023.00.28 T1_QO3R2jpg - o
250.46x106.88 mm (1092x466); 8-bit, 497K

V e

Measure

Deselect
Properties
Flatten F]

e

e 4 Imagel = X

File Edit Image Process [[NEI%Z Plugins Window Help
Measure Ctrl+M ‘/‘@‘/‘ ‘ ‘ ]»
Analyze Particles...
Summarize

g Label
Clear Results
Set Measurements...

Save XY Coordinates...
Fractal Box Count.
Set Scale... Analyze Line Graph
Calibrate... Curve Fitting...
[¢ il ROl Managy
Ctrl+K | Scale Bar...
Calibration Bar...

Histogram
Plot Profile
Surface Plot...
Gels | Synchronize Windows

| 4 20230028 T1 Qo3R2jpg
250 46x106.88 mm (1092466): 8-bit, 497K

0051-0477

Ueselect
Properties.

¥ Show All
|+ | Labels

sults

.| File Edit Font Results
[Area [Mean [Min [Max |
511.952 0 0 0

1

2 533.046
3 500.379
4

5

492751

[t 118.993

File Edit Image Process § Plugins Window Help

Woyojcjol /£ pleald e sle] ] | | |» :

0
0
0
0

Figure 12 : Avec l'outil Wand (encerclé en rouge), sélectionner une feuille (elle sera encadrée en jaune),
cliquer sur Add (encerclé en bleu) pour 'ajouter a la liste. Cliquer sur chacune des feuilles pour les ajouter a
la liste. Lorsque toutes les feuilles sont sélectionnées, cliquer sur Measure (encerclé en vert) pour obtenir
l'air de chaque feuille sélectionnée (Area).
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Estimation de I'aire moyenne des feuilles par masque, méthode alternative’®

Cette méthode est une alternative a la mesure de la longueur et la largeur des plants. Elle
remplace les étapes 22 a 28 du protocole. Elle permet une estimation de I'aire des feuilles
plus rapide, mais ne permet pas de connaitre les mesures longueur et de largeur des

plants ni de connaitre le nombre de feuilles par plant.

Matériel

[J Surface blanche : feuille de papier hydrofuge ou laminé blanc (8,5 “ x 11”)

[1 Surface transparente : plaque de verre ou feuille d’acétate ou d’acrylique transpa-
rent (8,5 x 11”)

[l Régle de 15 cm graduée en mm (peut étre imprimé directement sur la feuille
blanche)

71 Etiquettes d’'identification (site, transect et quadrat)

[J Photocopieuse ou numériseur
Pour les trois plants sélectionnés dans I'échantillon :

35. Couper les feuilles a la base de la gaine puis, sur la surface transparente, étaler les
feuilles des trois plants. Si les feuilles sont plus longues que la surface, il est possible
de les couper en plusieurs segments avant de les étendre (figure 8);

36. Placer la regle et I'étiquette d’identification sur la surface transparente, face vers le
bas. Placer la surface blanche sur le dessus des plants. Veiller a ce que les plants,
I'étiquette et la régle ne se superposent pas;

37. Faire une photocopie des plants (figure 13);

38. La surface totale des feuilles peut étre estimée a partir de cette image en utilisant la

méthode décrite aux étapes 28 a 34.

3Tran (2019)
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Figure 13 : Photocopie des plants d’'un méme échantillon
1 pour l'estimation du LAl. Tous les segments des plants sont
placés a plat sur une surface transparente ainsi que I'éti-
| quette d’identification et une régle graduée. Cette figure
¥ est tirée de Tran (2019).

! !

!
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INDICES

Indice surface foliaire

L’indice surface foliaire (Leaf Area Index ou LAI) est une dimension exprimée sans unités
qui permet d’évaluée I'aire des feuilles en fonction de la surface du sol (ou du substrat).
Le LA/l est calculé en rapportant le total de l'aire d’un cété des feuilles par la surface
échantillonnée. L’aire totale des feuilles est estimée a partir de la moyenne de la surface

des trois répliquas.
On le calcule le LA/ ainsi :

aire totale R1 + aire totale R2 + aire total R3
3

X densité = LAI

Exemple de calcul :

Aire des répliquas

R1 :4587 mm?= 45,87 cm? = 0,004587 m?
R2 :3329 mm?= 33,29 cm? = 0,003329 m?
R3:6123 mm?=61,23 cm? = 0,006123 m?
Densité : 2458 plants/m?

0,004587 + 0,003329 + 0,006123
3

X 2458 = 11,50

LAI = 11,50
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Calcul de la FW/DW

La biomasse foliaire séche (DW) est obtenue aprés un séchage des plants a 60°C pendant
48h. Cette mesure de biomasse est le plus souvent utilisée dans la littérature scientifique
afin de comparer les communautés entre elles. Cependant, le séchage des échantillons
demande des installations de laboratoire qui ne sont pas accessibles a toutes les organi-

sations impliquées dans le suivi des herbiers marins.

Un indice préliminaire de conversion entre la masse séche et la masse humide a été cal-
culé a partir des mesures de biomasse fraiche et séche de 148 échantillons récoltés a

Rimouski sur une période de 6 mois (mai a octobre 2023).

Les données récoltées en 2024 (sur une variété de sites et de dates) serviront a renforcer

la puissance statistique et assurer I'applicabilité du facteur de conversion.

DW = (0,16 + 0.002) x FW
R? = 0.9786

Tableau 1 : Facteurs de conversion entre masse seche et masse fraiche pour les données de biomasses

récoltées a Rimouski en été 2023

Date Pente Intervalle de con- R2 n Erreur Std
fiance (95%)

Eté 2023 0.1616 [0.1579; 0.1653] 0.9786 148 0.001881
2023-05-05 0.2022 [0.1935; 0.2108] 0.9955 12 0.003935
2023-05-18 0.1844 [0.1761; 0.1927] 0.995 12 0.003777
2023-06-05 0.1861 [0.1670; 0.2051] 0.9747 12 0.008643
2023-06-19 0.1746 [0.1631; 0.1860] 0.9894 12 0.005206
2023-07-05 0.1580 [0.1326; 0.1832] 0.9404 12 0.01145
2023-07-20 0.1664 [0.1570; 0.1757] 0.9875 18 0.004418
2023-08-03 0.1481 [0.1384; 0.1579] 0.9893 12 0.004445
2023-08-17 0.1679 [0.1622; 0.1736] 0.9972 12 0.002577
2023-08-31 0.1826 [0.1669; 0.1984] 0.9818 12 0.007163
2023-09-14 0.1397 [0.1321; 0.1472] 0.9928 12 0.003433
2023-09-28 0.1660 [0.1552; 0.1767] 0.9897 12 0.004878
2023-10-16 0.1998 [0.1894; 0.2102] 0.9933 12 0.004743
2023-10-31 0.1563 [0.1494; 0.1632] 0.9957 12 0.003086
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